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In the beginning…

• On the first day ESRI gave us
– Arc/Info (pre-1999)

– ArcView (day 1.6)

• On the second day ESRI gave us
– ArcMap 8.0 (1999)

• On the third day ESRI gave us
– ArcGIS Desktop 8.1 (April 24th, 2001)

– ArcGIS Online 

• On the fourth day ESRI gave us
– ArcGIS 9.0 (May 11th , 2004)

• On the fifth day ESRI gave us
– ArcGIS 10.0 (June 29th , 2010)



In the beginning…

• On the sixth day the GIS people cried out that ArcGIS Online is the 
future of GIS. We need a better tool.

• On the seventh day ESRI gave us
– ArcGIS Pro (January, 2015)

– And it was OK 
• The people cried out for something better

– In June, 2017 ESRI gave us ArcGIS Pro 2.0

• And it is awesome 
• And there was much rejoicing 

– I was there, I remember 



What is ArcGIS Pro?

• Combines various elements of ArcMap

• Similar functionality to ArcMap

• Built for ArcGIS Online
– Portal (follows AGOL)

• Feature Services
– Creating 

– Managing

• Multiple
– Maps

– Layouts

– And more



What I will not be talking about

• Initial installation

• Licensing

• Network administration

• Database set up and administration

• Everything
– Meaning there is enough material that a discussion could last weeks



What we will talk about

• Using ArcGIS Pro for the first time

• Basics of a new Project
– I will talk about basics, even though some things may not feel basic

– First time setup

– Start a new Project

• Add data

• Customize a Domain

• Customize a Feature Class

• Pop-ups

• Symbology

• Labels



Map exchange document vs Arc GIS Project 
file
• ArcMap – Map Exchange Document

– MXD

– One map

– One layout

– Common Toolbox

• ArcGIS PRoject File(X)
– APRX – Essentially creates a file system that links multiple functions 

together

– Multiple maps

– Multiple layouts

– Project specific toolbox



MAJOR DIFFERENCES

• File Geodatbase, SDE, Feature services, or ShapeFiles

• Personal Geodatabase

• Cannot edit Geometric Networks

• Auto backup of project

• Ease of switching between portals

• Edit sessions are optional
– Can cause havok

• Editing can be more cumbersome

• Editing no matter what the source



Initial set up: Online connection(s)

• Have your licensing set up

• Connection documents
– URL

– Login

– Password

• Start ArcGIS Pro >> Select 
Settings



Initial set up: Online connection(s)

• Select Portals

• Add Portal
– Add first 

connection

Existing connection(s)



Add Portal

• Text and Case sensitive
– FULL URL

• Select ellipses to
– Sign in

– Set As Active Portal

– Edit Portal Connection

– Test Availability

– Remove Portal Connection

• Shows currently active portal

• Shows portal status



Sign In

• Sign into the portal connection 
you want to work in

• ArcGIS Online 
– AGOL

– Most common

• Portal 
– Enterprise GIS

– Less common

• Go back to the home screen



Initial set up

• Start ArcGIS Pro >> Start without a template



Untitled – ArcGIS Pro

• Pro will launch with an untitled project

• Why use untitled 
– Perform functions you don’t need to save

– Set up connections

• Folders

• Databases

– Customize settings



Familiarize yourself with the layout
Quick Access Project name Current log in 

and portal
Menu buttons

Menu items

Table of contents 
and so much more 
will be here when 
a project is started    

Maps, layouts, 
attribute tables, 
and more will go 

here
Connections

Favorites
Databases

Portal
Folders

And more

Maps
&

Layouts



Set up Favorites

• One time set up of connections

– Folders

– Databases

– Toolboxes

– Servers

– Styles

– Statistical Data Collection

• Setting up Favorites will give you 
access to them for all new and 
existing projects

• Add Item to begin



Add your first connection

• Six connection options

– Add Folder 

– Database 

– Toolbox

– Server 

– Style

– Add Statistical  Data Collection



Add Folder

• Opens a Windows Explorer window

• Navigate to the folder you can to 
connect to and select OK

• Tip: we use a common folder with a 
defined structure to store all projects 
and files in a pre-defined manner



Add to New Projects

• The connected folder will appear in 
your list of folders

• Right click on the folder
– Add to Project 

• Add the folder to your current project

– Add to New Projects

• Add this folder to all new projects

• Add sub folders
– Portal Services (example)

• Folders in Catalog
– Shows the folders in the catalog

– 64-bit folder???   

• Will cover this in a bit



Add Database(s)

• Add Database 

– Just like adding a folder but a direct 
link to a database

– File Geodatabase only

• New File Geodatabase

– Create a new database that will be in 
Favorites

– Can also create in Catalog but will 
not be in Favorites

• New Database Connection



New Database Connection

• Database connection dialog
– Network databases

• You will need specific connection 
information for a network or a 
database connection file before 
continuing

• Database Platform
– Wide variety of database 

connections available

• Add Oracle connection
– Depends on your situation 



Add Oracle Connection

• Enter connection credentials

• Select OK

• Will now be a favorite in all 
new projects

• Main database
– Same option to add to all 

new projects



Add Server with Connection Files

• Multiple Server types

• Add Server
– Can use Server Connection Files

– Tip: create a folder on your 
common network folder with all 
your Connection Files. Make that 
folder a favorite first



Add Server manually

• New ArcGIS Server (does not 
create a server)

• NOTE: This information is case 
sensitive and must be entered 
exactly is it appears in your url

• From here you can create a 
connection file

• This connection will allow you to 
directly access services and 
maps you have published 



Add other services

• You can also add other services 
from trusted sources
– OGC API Server

– WCS

– WFS

– WMS

– WMTS



Add WMS Service

• Acquire the complete URL for 
the WMS service you want to 
add

• Complete URL starting with 
https://

• Best practice: if a WMS URL 
does not start with https:// it may 
not be safe to use



Add WMS Service

• Select add New WMS Server

• Paste the complete URL into 
the Server URL: dialog
– Authentication may be 

required depending on the 
source.

• The WMS service and all 
available layers will be added 
to your Favorites

• Use this option at your own 
discretion



Review your Project Connections

• Check the Project tab in Catalog 
and verify the default connections 
you want for all projects are 
included

• Styles will be populated with 
default ArcGIS Pro styles

• You can alter the Favorites at any 
time



Review your Portal

• Portal view options (from left to 
right)
– My Content

– My Favorites

– My Groups

– My Organization

– ArcGIS Enterprise

– Living Atlas

• 1436 items as of March 16th

• ESRI approved

• Change are automatically saved



ArcGIS Pro updates

• When updates are available for 
Pro you will see a notification in 
the upper right corner if you 
activated Checking for updates 
on startup

• Select Settings

• Select About

• To receive notice of available 
updates, check the box

• Press Download Now to update



Start a New Project

• Start ArcGIS Pro (Pro)
• Select Map from Blank 

Templates
• Create a New Project dialog 

will use defaults
• TIP: create a structured 

Master Project Folder if 
multiple projects will work in 
this folder

• Strongly encourage thought 
and planning at the beginning
– Everyone doing it the same 

way



Structured Folders

• Example
– PortalServices (network folder)

• Contains all Projects (aprx or 
mxd)

– Each folder contains ONLY 
information related to a specific 
project or feature service



Start a new Project

• Dialog will start with defaults

• Enter the logical Name for 
your Project that it will keep

• Location: this will create a 
new Folder that will store your 
project, or you can create a 
folder beforehand to place 
your project.

• You can store multiple Projects 
in the same Location

• Select OK REMEMBER THE VALUES 
ENTERED HERE



Project folder in Explorer & Catalog

• Folder name is what you entered 
in the Location dialog

• Name of the project is what you 
entered in the Name dialog

• Created a File Geodatebase for 
THIS project
– Replaces Default Database in 

ArcMap

• Created a Project .aprx

• Created a Project Toolbox

• ORGANIZED!

In Catalog you will not see the .aprx file.



New perk to ArcGIS Pro

• Pin projects to the start icon



New Project

• Contents

• Map

• Catalog

Project name

Table of 
contents and 

so much more 
will be here as 

the project 
progresses

Maps, layouts, 
attribute tables, 
and more will 

go here

Connections
Favorites

Databases
Portal

Folders
And more



Pro Project layout
• Contents (from the left)

– Drawing Order

– Data Source

– Selection

– Editing

– Snapping

– Labeling



Pro Project layout

• Center Panel
– Maps

– Layouts

– Tables

– Customization dialogs

• Domain management

• Feature Class managment



Pro Project layout

• Catalog (right side)
– Folder for Maps

– Folder for Layouts

• When you create one

– Toolboxes

• Project Specific

– Databases

• Project Specific

– Folders

• Project Specific



Project Database

• File GeoDataBase
• Catalog

– Accessing
• ArcCatalog

• Catalog via ArcGIS Pro

• Create Feature Datasets
• Create Feature Classes
• Create Tables
• Import/Export Data
• Relationships
• Domains



A few key differences

• Accessing Databases specific to 
a project
– Input

– Export

– Add Data

• All linked sources
– Database

– Folders

– Portal

– Computer



A Major Key Difference
Creating Feature Classes

• Creating a new Feature Class
– Name and Alias

• Import
– Can arrange the order of fields

• And/or Add New Fields
– Cannot assign a Domain

– At this time

• New Feature class is added to 
your map

• Remember this Feature Class
– DemoPoint



Adding existing MXD to Project

• Import from an MXD

• Insert > Import Map > Select MXD >  OK



Adding existing MXD to Project
• Adds Maps

• Add Layouts



About importing MXD’s to Project
• Will add multiple maps

– May be the same map

• ArcGIS Online does not do well with complex symbology and 
non-standard colors
– Stick to the basic Fonts

• Huge benefit to have one set of maps for multiple layouts.

• May be better off re-creating the MXD from scratch
– Unless MXD’s are identical in nature there may be differences in the 

layouts and display of data

• May change appearances of some objects



Adding Feature Classes to Map

• With the Map tab selected

• Select 
– Add Data

• Navigate to your data and add it

• It will appear in your Contents



Data Design intro

• Data Design 
– Right click on Feature Class

• Design or alter
– Domains

– Fields

– Subtypes

– Attribute Rules

– Contingent Values



Data Design: Domains
• Right click on the Feature Class

– Data Design > Domains

• You do not need to do this first

• Domains are built similar to ArcMAP

• Stored in the database and not the project



Data Design: Fields (permanent)
• Data Design > Fields

• Field Name
– Feature Class Unique

• Just like ArcMAP

• Changes go back to the database

Save your changes



Data Design: Fields (Project only)
• What this means

• Certain changes in Data Design stay with the Project and are not 
permanent in the Database
– Field Order

– Visibility 

– Highlighted

– Etc.

• Feature Class can be copied from one Map Tab to another Map 
Tab and maintain changes

• Allow you to display the exact same data in numerous ways



Data Design: Fields (Project only, mostly)
• Re-order fields

• Turn them on or off

• Make Read Only

• Changes are marked with in 
green

• Mostly Project only
– If you delete a field, it is a 

permanent database 
change. 

Save your changes



Symbology notes
• ArcGIS Pro was in strong part designed around publishing content for 

ArcGIS Online

• Complex symbols do not work well online
– Fonts

– Multiple symbol layers

– Etc.

• You may need to adjust your symbols to what ArcGIS online can support
– May not publish

• While symbols are designed to be simpler you will find there are a lot 
more options for configuring your symbols



Creating Symbology

• Right click feature and select 
Symbology to bring up the 
Symbology dialog

• Similar options to ArcMAP
– Select Unique Values



Creating Symbology

• Select Field 1
– Add Fields if needed

• Add values

• Double Click a symbol to change 
it



Modify Symbology

• Select your symbol

• Select Properties to customize it

• This is where it starts to get 
complex



Symbol Properties Tabs

• Symbol tab
– Color

– Outline

– Outline Width

– Size

– Angle

– Angle alignment

• Orient to Map (north) or Display

– Halo

• All very similar to ArcMap



Symbol Properties Tabs

• Layers tab
– Change shape of base symbol

– Change original style of symbol

• Using ESRI Fonts you can create 
fonts similar to ArcMAP



Symbol Properties Tabs: Layers

• Layers
– Add effect

– Add symbol layer

• Add multiple layers

• This subject is a whole set of 
lectures



Pop-ups

• Powerful tool
– Text

– Fields

– Images
• Hyperlink

• URL

– Charts
• Based on data

– Carousel
• Charts and Images

• Right click Feature Class and 
select Configure Popups



Pop-ups: Title

• Allows a combination of Text and 
fields

• Click on the Title dialog

• Select the back arrow to view 
your update

• Add custom text

• Pull fields in from drop down



Test your Pop-up

• Select a feature in your map to 
test your pop-up Title



Pop-ups: Fields

• Select Fields then the pencil icon to 
edit Fields

• Optional
– Add custom title

– Add custom caption

• Only use visible fields…
– Uncheck to see Fields

• Uncheck fields you do not want to 
see

• Can re-order fields in the Pop-up
– Only effects the Pop-up



Test your Pop-up

• Select a feature in your map to 
test your pop-up Title



Pop-ups: Text

• Add a text field and edit

• Like the title you can add text and 
fields in any combination

• Add colors

• HTML mode



Test your Pop-up

• Select a feature in your map to 
test your pop-up Title



Labels

• Right click to access Labeling 
Properties and turn on labels

• Can be very in depth
– Similar to Maplex

• More options

• Optional Languages 
– Arcade

– VBScript

– Jscript

– Python

• Manage Classes



Customize an Arcade label

• Label Expression
– Arcade uses specific pointers to 

the data

• $feature.OBJECTID

• Case Sensitive

• SQL

• Visibility Range



Basic Arcade Scripting

• Requires Arcade database name
– $feature.{Field}

• Add fields with a double click

• Plus sign “+” instead of 
ampersand “&”

• Apostrophe ‘<text>’ instead of 
quotation mark “<text>”

• Select Check mark to verify 
expression

• Select Rewind to rest expression
Select Apply when finished



View your Label 

• You can customize the colors and 
position with the Symbol and 
Position options

• Dozens and dozens of options 
and variables
– Stacking

– Weight

– Buffers

– Halos

– Etc.



Layouts

• Insert
– New Layout

• Select size

– Can change the size later

• Open the catalog
– Maps

• Drag desired map or maps into 
the Layout



Layouts overview

Layout 
elements

Multiple layouts using the same System Map 
in a single project

Locks



Define a Map Series

• From the Layout Tab
– Select 

• None

• Spatial

• Bookmark



Define your Series

• Like Data Driven Pages

• However
– Group by

• Use an Attribute

• Page Number
– Default will be ascending by Sort 

field

– Can specify by Attribute



Layout elements

• Map Series Pages

• Right click
– Navigate to page

– Export to File…

• 12 types 

– Print



Layouts: other content types

• List by drawing order
– All elements

– No more sending to back or 
bringing to front

• Element Type
– All elements sorted by type

• List by Map Frame
– All Maps in a layout



Setting Map Properties

• Right click on Map
– Wide variety of options

• Select Properties



General properties

• Set Name
– Hint: if you are going to publish 

this map name it after the 
service you are going to publish



Metadata

• Metadata
– Title

– Tags

– Summary

– Description

• Hint: if you are going to publish 
this map as a service fill in the 
Metadata as you will want it to be 
seen in ArcGIS Online



Share > Publish as Web Layer

• Share > Web Layer > Publish 
Web Layer

• Name, summary, and Tags
– Appear when publishing

• Pulled from properties

• Description
– Visible as metadata in the 

published service



Share > Publish as Web Layer

• Prefilled from Properties

• Choose service typs
– Map Image

• View only

– Feature

• Editable 

• Can publish directly to a Portal 
folder (Service management)

• Designate which server

• Designate or create a folder on 
Portal for managing elements

https://maps.domain.com:####/arcgis



Questions?



What would you 
like to see?


